# TABLE OF CONTENTS

1. Introduction ........................................................................................................... 1

2. Operation ............................................................................................................... 3
   2.1 Installation ......................................................................................................... 3
   2.2 Interfacing with ZL6 Using a Computer ............................................................ 5
       2.2.1 Configuration ............................................................................................... 5
       2.2.2 Communication Test (ZL6 and ZL6 Pro) ...................................................... 9
       2.2.3 Instantaneous Sensor Measurements Scan ................................................. 10
       2.2.4 Data Download ............................................................................................ 10
       2.2.5 Data Deletion ............................................................................................... 11
   2.3 Interfacing with ZL6 Using a Smartphone or Tablet ......................................... 11
       2.3.1 Connection .................................................................................................. 11
       2.3.2 Configuration ............................................................................................... 13
       2.3.3 Communication Test (ZL6 Cellular and ZL6 Pro) ...................................... 15
       2.3.4 Instantaneous Sensor Measurements Scan ................................................. 16

3. System .................................................................................................................... 17
   3.1 Specifications ..................................................................................................... 17
   3.2 Hardware Components ....................................................................................... 20
       3.2.1 Sensor Interface ......................................................................................... 21
       3.2.2 Sensor Measurement Interval ...................................................................... 22
       3.2.3 Test Button .................................................................................................. 22
       3.2.4 Status Lights ............................................................................................... 23
       3.2.5 Batteries ....................................................................................................... 23
       3.2.6 GPS Receiver (ZL6 Select models) .............................................................. 24
       3.2.7 Timekeeping ................................................................................................ 24
3.2.8 Data Storage ................................................................................................. 25
3.2.9 Zentra Cloud Communications (ZL6 and ZL6 Pro) .......................... 25

4. **Wi-fi Communication** .................................................................................. 26
   4.1 Configuring ZL6 for Wi-Fi Networks ......................................................... 26
   4.2 Open Network Configuration .................................................................. 28
   4.3 Secured Personal Network Configuration ............................................. 29
   4.4 Secured Enterprise Network Configuration .......................................... 30
   4.5 Hidden Wi-Fi Network Configuration ....................................................... 31
   4.6 Incompatible Wi-Fi Networks ................................................................. 32
   4.7 Communication Test ............................................................................. 33
   4.8 Using the ZL6 Indoors ........................................................................... 33
   4.9 Troubleshooting Wi-Fi Connections ....................................................... 33

5. **ZENTRA Software** .................................................................................... 34
   5.1 ZENTRA Utility Mobile ........................................................................ 34
   5.2 ZENTRA Utility .......................................................................................... 35
      5.2.1 Button Toolbar .................................................................................. 35
      5.2.2 Data Logger Identification Area ....................................................... 36
      5.2.3 Active Sensors and Measurements Area .......................................... 36
      5.2.4 Status Bar ....................................................................................... 36
      5.2.5 Menu Bar......................................................................................... 37
   5.3 ZENTRA Cloud ......................................................................................... 46

6. **Service** .................................................................................................... 48
   6.1 Maintenance .............................................................................................. 48
   6.2 Troubleshooting ....................................................................................... 49
   6.3 Customer Support ..................................................................................... 52
   6.4 Terms and Conditions ............................................................................ 52

   A.1 USA ........................................................................................................ 53
A.2 Canada........................................................................................................53
A.3 European Union .........................................................................................54
A.4 Japan ..........................................................................................................55

Index .............................................................................................................56
1. INTRODUCTION

Thank you for choosing the ZL6 data logger from METER Group. The ZL6 loggers are part of the ZENTRA System: a collection of data loggers, software, and compatible sensors to measure environmental parameters accurately and cost effectively. Please refer to metergroup.com/logger-compatibility for a list of supported sensors.

This manual covers the ZL6 Basic, the ZL6, and the ZL6 Pro with their corresponding communication options. Throughout this manual, all three loggers will be referred to as ZL6 unless otherwise noted. The primary differences between the loggers are in Table 1.

<table>
<thead>
<tr>
<th>Feature</th>
<th>ZL6 Basic</th>
<th>ZL6</th>
<th>ZL6 Pro</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long-range telemetry hardware for automatic uploads to ZENTRA Cloud</td>
<td>None</td>
<td>3G or 4G cellular Wi-Fi communication</td>
<td>3G or 4G cellular</td>
</tr>
<tr>
<td>Hourly data uploads</td>
<td>None</td>
<td>Included</td>
<td>Included</td>
</tr>
<tr>
<td>15 minute data uploads</td>
<td>None</td>
<td>Sold separately</td>
<td>Included</td>
</tr>
<tr>
<td>At measurement intervals data upload</td>
<td>None</td>
<td>Wi-Fi communication only</td>
<td>None</td>
</tr>
<tr>
<td>GPS for position and timekeeping</td>
<td>None</td>
<td>Included</td>
<td>Included</td>
</tr>
<tr>
<td>Battery technology</td>
<td>Alkaline</td>
<td>NiMH or alkaline</td>
<td>NiMH or alkaline</td>
</tr>
<tr>
<td>Battery charging</td>
<td>None</td>
<td>Integrated solar panel</td>
<td>Integrated solar panel</td>
</tr>
<tr>
<td>Measurement interval</td>
<td>60 min</td>
<td>5 min to 12 h</td>
<td>5 min to 12 h</td>
</tr>
<tr>
<td>Flash data storage</td>
<td>2 MB</td>
<td>8 MB</td>
<td>8 MB</td>
</tr>
<tr>
<td>Reference barometer</td>
<td>Sold separately</td>
<td>Included</td>
<td>Included</td>
</tr>
<tr>
<td>Sensor cable strain relief</td>
<td>Sold separately</td>
<td>Included</td>
<td>Included</td>
</tr>
<tr>
<td>ZENTRA Cloud subscription</td>
<td>Sold separately</td>
<td>Sold separately</td>
<td>3 years</td>
</tr>
<tr>
<td>Warranty</td>
<td>1 year</td>
<td>1 year</td>
<td>3 years</td>
</tr>
</tbody>
</table>
Verify all instrument components are included and appear in good condition:

- ZL6 series logger
- Device ZENTRA Cloud subscription sticker (inside the logger)
- Six batteries
  - Alkaline for ZL6 Basic
  - NiMH rechargeable for ZL6 and ZL6 Pro
- Micro-USB communications cable
- UV-stable plastic zip ties
- Spare parts kit (ZL6 Pro only)
2. OPERATION

This section explains the basic workflow of logger installation, logger configuration, and data download. Please read all instructions before operating the ZL6 to ensure it performs to its full potential. Consider testing the ZL6 and sensors in a lab or office prior to field installation to verify the correct operation of the system.

The ZL6 can serve as a data collection station for as many as six sensors. It is designed for plug-and-play setup with all METER sensors, including the ATMOS weather sensors, TEROS soil moisture sensors, HYDROS water sensors, PHYTOS leaf sensors, and ECH₂O soil moisture sensors. Please refer to the individual sensor manuals for sensor installation instructions.

NOTE: To use TEROS 31 and TEROS 32 sensors with the ZL6 Basic, a reference barometer sensor must be added to the logger. Contact Customer Support.

2.1 INSTALLATION

Follow the steps listed in Table 2 to set up the ZL6 and start collecting data.

NOTE: Never immerse the ZL6 in liquids or bury the ZL6. This and other misuse, improper protection, or improper installation may damage the ZL6 and void the warranty.

<table>
<thead>
<tr>
<th>Table 2</th>
<th>Installation</th>
</tr>
</thead>
</table>
| Tools Needed | Microsoft® Windows® or Apple® Mac® computer for ZENTRA Utility  
Apple® iPhone® (iOS 9.0 or newer) or Google Android™ smartphone (Android 4.3 or newer) for ZENTRA Utility Mobile  
Mounting post (or similar) |
| Preparation | Install ZENTRA Utility or ZENTRA Utility  
To install ZENTRA Utility Mobile on a smartphone or tablet:  
• Open the app store.  
• Search for ZENTRA Utility.  
• Download the application.  
To install ZENTRA Utility on a computer:  
• Navigate to the ZL6 webpage (metergroup.com/zl6-support).  
• Click the appropriate ZENTRA Utility Installer link.  
• Click through the ZENTRA Utility Installer wizard.  
The installer automatically installs the necessary USB driver for the ZL6. |
| | Install Batteries  
Press the TEST button on the logger. The status lights will eventually settle to a green short, single blink every 5 s, signaling it is ready for use. |
### Configuration

**Configure the ZL6 Using ZENTRA Utility**

On the ZL6, push the **TEST** button on the logger to ensure the Bluetooth® module is activated.

On the mobile device, open ZENTRA Utility.

Select the ZL6 to connect.

Select **Configure** and set the desired cellular data upload settings (for ZL6 and ZL6 Pro) and sensor measurement interval (*Section 2.3.2*). For Wi-Fi configuration see (*Section 4.1*).

**NOTE:** Configuration using ZENTRA Utility for Mac® and Windows® is addressed in *Section 2.2.1*.

### Field Installation

**Select Location**

Choose the desired location based on relevant details including: representative field position for sensor installation, vegetation cover throughout the season, distance from power lines, minimal livestock interference, etc.

For ZL6 and ZL6 Pro, orient the solar panel to give it the maximum amount of sunlight. In the northern hemisphere this will typically mean the data logger will face south; in the southern hemisphere this will typically mean the data logger will face north.

**NOTE:** If the location is in an area where solar energy harvesting is minimal, alkaline batteries will power the logger longer than the NiMH batteries when not being recharged by the solar panel. The ZL6 does not charge alkaline batteries.

**Check Communication Quality**

Evaluate how surroundings may attenuate the cellular or Wi-Fi signals. Large metallic objects, power lines, and plant canopies may block communication signals.

Use ZENTRA Utility to check the communication of the cellular signal (*Section 2.2.2*) or Wi-Fi signal (*Section 4.7*).

If the signal is low or the communication test fails, move to an alternative location (sometimes moving only a few meters is sufficient).

**Fasten Logger to Mounting Post**

Use the loopholes on the back of the logger enclosure to mount the ZL6 to a post using zip ties or a similar fastener (such as hose clamps).

Ensure the logger is installed in an upright position to reduce the possibility of water entering the ZL6 enclosure.

**NOTE:** The ZL6 case is water resistant, not waterproof. In extremely wet environments or environments with prolonged high humidity, place a desiccant packet inside the logger or enclose the logger in a waterproof case.
Table 2  Installation (continued)

<table>
<thead>
<tr>
<th>Field Installation (continued)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Sensors</td>
<td></td>
</tr>
<tr>
<td>Install each sensor as directed in the sensor user manual.</td>
<td></td>
</tr>
<tr>
<td>Thread cables near the ground through conduit or plastic cladding to avoid damage.</td>
<td></td>
</tr>
<tr>
<td>Plug the sensor stereo plug connectors firmly into the ZL6 input ports.</td>
<td></td>
</tr>
<tr>
<td>Put each cable in the corresponding strain relief hook and use thumb screws to tighten the strain relief hook.</td>
<td></td>
</tr>
<tr>
<td>Perform instantaneous scan to ensure sensors are working properly (<a href="#">Section 2.2.3</a>).</td>
<td></td>
</tr>
</tbody>
</table>

## 2.2  INTERFACING WITH ZL6 USING A COMPUTER

Download ZENTRA Utility from the ZL6 webpage ([metergroup.com/zl6-support](http://metergroup.com/zl6-support)) before going to the field. Add ZENTRA Cloud user credentials to allow uploading data.

### 2.2.1  CONFIGURATION

The measurement interval and sensor types must be set before data will be correctly stored by the logger.

To configure the ZL6 in ZENTRA Utility, refer to the following steps:

1. Plug the micro-USB cable into the logger USB port and the computer USB port.
2. Open the ZENTRA Utility application ([Figure 1](#)).

![Figure 1](#)  ZENTRA Utility initial screen with ZL6 in COM port dropdown
On the ZENTRA Utility main screen, the connected ZL6 should appear in the dropdown menu. If the logger designation does not appear in the dropdown, try a different port or cable.

3. Click the **Connect** button next to the **COM** port dropdown menu (**Figure 2**). Once successfully connected, ZENTRA Utility displays the instantaneous sensor measurements from the ZL6 (**Figure 2**).

![ZENTRA Utility showing a connected ZL6 and its instantaneous measurements](image)

**Figure 2** ZENTRA Utility showing a connected ZL6 and its instantaneous measurements

4. Click **Settings** in the Button toolbar.
   
The Manage Settings dialog will appear.

5. Navigate to the Device Information tab (**Figure 3**).
6. Enter a device name. This value is prepopulated with the device serial number. Consider changing the name to the field or plot where the ZL6 is installed.

7. Navigate to the Sensor Configuration tab (Figure 4).

![Figure 3 Device Information tab](image)

![Figure 4 Sensor Configuration tab](image)
8. Adjust the Measurement Interval to the desired time for storing sensor measurements. The ZL6 Basic has a fixed measurement interval of 60 min. Section 3.2.2 provides more information on how the ZL6 makes measurements.

9. Confirm all sensors are plugged into the ZL6.

10. Ensure the correct sensor type is listed in each port tab (Figure 5).

   If the sensor is not automatically recognized, pick the correct sensor setting from the Sensor Type dropdown menu.

   NOTE: Check the cellular signal (Section 2.2.2) for ZL6 and ZL6 Pro loggers at the expected installation location before installing sensors.

    ![Select Sensor Type dropdown](Figure 5)

   ZL6 Basic logger configuration is complete at this point. ZL6 and ZL6 Pro logger configuration will need to continue to step 11 through step 13 to set up the desired data upload times.

11. Navigate to the Communication Settings tab (Figure 6).
12. Select the time segments in Upload Times by clicking the arc segments for the hour intervals.

The ZL6 will upload data during the selected intervals (Section 4.2.5.1).

13. Click OK.

2.2.2 COMMUNICATION TEST (ZL6 AND ZL6 PRO)

A successful communication test will confirm that the ZL6 can transmit data to ZENTRA Cloud servers as well as provide the quality of the connection. Even a poor connection status allows data to be successfully transferred. Prior to installing the sensors and the ZL6, check the quality of the connection at the location:

1. In ZENTRA Utility, click the Test button in the Button toolbar.

The Communication Test dialog will appear (Figure 7).
2. Click Test.

3. If the logger fails the test, move to a new location and try again. Sometimes, moving just a few meters will provide a successful connection.

   NOTE: The ZL6 antenna is inside the enclosure. An antenna extension cable can also be used to elevate the antenna for increased signal strength. Contact Customer Support for more information.

4. Click Close.

2.2.3 INSTANTANEOUS SENSOR MEASUREMENTS SCAN

ZENTRA Utility will automatically scan the sensors attached to the ZL6 every 30 s and update the readings shown on the main screen (Section 4.2.3).

ZENTRA Utility can also take real-time sensor measurements on demand. This is a critical tool to ensure sensors are installed correctly, to test if a sensor is reading properly, or to evaluate how sensors react to environmental changes. The ZL6 does not store data that it measures with the scan function.

To force a new scan at any time, press the Scan button in the Button toolbar (Section 4.2.1). The sensor and measurement area will refresh.

2.2.4 DATA DOWNLOAD

While at the installation site, allow the ZL6 to collect data for one or two measurement intervals, and download the collected sensor data to ensure the monitoring setup is working correctly. Periodically return to the site to download the stored data, to check the logger operation, and to retrieve stored data.

Download saved sensor and status data with ZENTRA Utility using the following steps:

1. Connect the logger to a computer using the micro-USB cable.
2. Open ZENTRA Utility.
3. Choose the appropriate COM port from the dropdown list.
4. Click Connect.
5. Click Download on the Button toolbar. This will download the data stored since the last successful download.

   Alternatively, go to the Data menu in the Menu bar and select either Download New (downloads the data stored since previous download) or Download All (downloads all the data currently stored in the ZL6).

6. Edit the File Name in the Save dialog. A suggestion will appear, based on the connected logger name and the time and date.
7. Select the location on the computer where the file will be saved.
8. Click Save.
ZENTRA Utility downloads sensor data and creates a Microsoft Excel® compatible file. The time-series sensor data saves to the Processed Records sheet of the workbook with metadata saved to the Metadata sheet. Metadata includes logger configuration settings, logger location, and sensor metadata, such as serial number and firmware version.

ZENTRA Utility will download data in the units chosen under Measurements in Manage Preferences dialog (Section 4.2.5).

2.2.5 DATA DELETION

It is not necessary to delete data on the ZL6. Once all of the memory has been used, the ZL6 will start overwriting the data starting with the oldest records.

Erasing stored data is done with ZENTRA Utility. Before erasing data, download and save data onto a computer.

CAUTION: This feature permanently erases all stored data on the ZL6. Data previously transmitted to ZENTRA Cloud are not erased.

To erase data, follow the steps below:

1. In ZENTRA Utility click on the Data menu on the Menu bar.
3. Click Erase Data to remove data or click Cancel to return to the main screen.

2.3 INTERFACING WITH ZL6 USING A SMARTPHONE OR TABLET

Download ZENTRA Utility from the app store before going to the field. Add ZENTRA Cloud user credentials to allow uploading data.

2.3.1 CONNECTION

The ZL6 shuts off the Bluetooth radio between connection sessions to save battery power. It is necessary to enable Bluetooth before trying to connect.

1. On the ZL6 press the TEST button to enable Bluetooth advertising.
2. On the mobile device launch ZENTRA Utility Mobile.

   Look for the ZL6 in the Devices Found window (Figure 8).
3. Select the ZL6 to establish a connection. Once connected, ZENTRA Utility Mobile shows logger information and instantaneous sensor readings (Figure 9).
2.3.2 CONFIGURATION
The measurement interval and sensor types must be set before data will be correctly stored by the logger.

1. On the ZL6, press the TEST button to enable Bluetooth advertising.
2. On the mobile device, open ZENTRA Utility Mobile.
4. Select Configure on the Actions panel (Figure 10).

![Figure 10 Select Configure](image)

The Configure Device screen will appear (Figure 11).
5. Enter a device name (Figure 11).

   This value is prepopulated with the device serial number. Consider changing the name to the field or plot where the ZL6 is installed.

6. Enter a site name if desired.

7. In the Sensor Configuration panel verify the Measurement Interval is set to store data.

8. Verify each logger port is configured correctly for the installed sensor.

9. Click Save to send the updated parameters to the logger.

   ZL6 Basic logger configuration is complete at this point. ZL6 and ZL6 Pro logger configuration will need to continue to step 10 through step 15 to set up the desired data upload times.

10. In the Communication Configuration panel, select Configure Cellular. See section (Section 4.1) for Wi-Fi communication configuration.

11. Select Upload Frequency to open the selection menu.

12. Choose upload frequency.

13. Select Done.

14. Select the time segments by clicking the arc segments for the hour intervals.

   The ZL6 will upload data during the selected intervals (Section 4.2.5.1).

15. Click OK.
2.3.3 COMMUNICATION TEST (ZL6 CELLULAR AND ZL6 PRO)

A successful communication test will confirm that the ZL6 can transmit data to ZENTRA Cloud servers as well as provide the quality of the cellular connection. Even a poor connection status allows data to be successfully transferred. Prior to installing the sensors and the ZL6, check the cellular connection at the location:

1. Select the Test button on the Actions panel (Figure 12).

   ![Figure 12 Select Test to begin Communication Test](image)

2. Select Start test.

   ![Figure 13 Select Start to begin the test](image)
If the logger fails the test, move to a new location and try again. Sometimes, moving just a few meters will provide a successful connection.

**NOTE:** The ZL6 antenna is inside the enclosure. An external antenna on an extension cable can also be used to for increased signal strength. Contact Customer Support for more information.

3. Click **Close**.

### 2.3.4 INSTANTANEOUS SENSOR MEASUREMENTS SCAN

ZENTRA Utility Mobile will automatically scan the sensors attached to the ZL6 every 30 s and update the sensor readings.

ZENTRA Utility Mobile can also take real-time sensor measurements on demand. This is a critical tool to ensure sensors are installed correctly, to test if a sensor is reading properly, or to evaluate how sensors react to environmental changes. The ZL6 does not store data that it measures with the scan function.

To force a new scan at any time, swipe down on the main screen. The sensor measurement area will refresh.
3. SYSTEM
This section reviews the ZL6 data logger hardware features and configuration options. Use this information to help optimize each environmental monitoring setup.

3.1 SPECIFICATIONS

MEASUREMENT SPECIFICATIONS

<table>
<thead>
<tr>
<th>Sensor Logging Interval</th>
<th>ZL6 Basic</th>
<th>60 min (average or accumulation of 60, 1-min sensor readings)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ZL6 and ZL6 Pro</td>
<td>5 min to 12 h (average or accumulation of 1-min sensor reading)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Logger Reporting Interval</th>
<th>ZL6 Basic</th>
<th>None</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZL6</td>
<td>Hourly with additional charges for more frequent reporting</td>
<td></td>
</tr>
<tr>
<td>ZL6 Pro</td>
<td>Hourly with the ability to enable more frequent reporting</td>
<td></td>
</tr>
<tr>
<td>ZL6 Wi-Fi communication</td>
<td>Upload after each measurement interval</td>
<td></td>
</tr>
</tbody>
</table>

| Timekeeping               | ZL6 Basic | Synchronize with ZENTRA Utility or ZENTRA Utility Mobile |
|                           | ZL6 and ZL6 Pro | Synchronize automatically and on-demand; GPS, cellular or Wi-Fi communication, or ZENTRA Utility software |

COMMUNICATION SPECIFICATIONS

<table>
<thead>
<tr>
<th>Computer Communication</th>
<th>Standard USB cable, USB A to micro-USB B</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Cellular Communication (ZL6 and ZL6 Pro)</th>
<th>3G</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifications</td>
<td>UMTS 3G 5-band cellular module with 2G fallback</td>
</tr>
</tbody>
</table>
### SYSTEM

| Coverage | 550+ global partner carriers  
Cellular and data hosting service provided by METER |
|----------|----------------------------------------------------------------------------------|

**4G LTE-M: USA, Canada, and select other countries**  
Contact Customer Support or a METER sales partner for more information.

<table>
<thead>
<tr>
<th>Specifications</th>
<th>4G LTE-M and NB-IoT cellular</th>
</tr>
</thead>
</table>

| Coverage | Verizon®, AT&T®, and T-Mobile® in the USA.  
Select global partner carriers.  
Cellular and data hosting service provided by METER |
|----------|----------------------------------------------------------------------------------|

**4G LTE Cat 1 Cellular Communication**

<table>
<thead>
<tr>
<th>Specifications</th>
<th>LTE Cat 1 cellular module with 3G and 2G fallback</th>
</tr>
</thead>
</table>

| Coverage | AT&T, and T-Mobile in the USA.  
550+ global partner carriers  
Cellular and data hosting provided by METER |
|----------|----------------------------------------------------------------------------------|

**Wi-Fi Communication (ZL6)**

<table>
<thead>
<tr>
<th>Specifications</th>
<th>IEEE 802.11b/g/n 2.4 GHz</th>
</tr>
</thead>
</table>

| Supported Channels | 1-11 in the USA and most regions of the world  
12-13 when hardware detects ETSI/UKCA region |
|--------------------|------------------------------------------------------------------|

| Supported Wi-Fi Networks | Open personal networks  
Secure personal networks  
Secure personal networks using WPA/WPA2/WPA3  
Enterprise networks using LEAP and PEAP security methods |
|--------------------------|---------------------------------------------------------------|

**Bluetooth Communication**

Bluetooth 5.2- Bluetooth Low Energy protocol for communication with iOS and Android mobile devices.

**GPS Communication (ZL6 and ZL6 Pro)**

<table>
<thead>
<tr>
<th>Type</th>
<th>Integrated 56-channel GPS/QZSS receiver</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Update</th>
<th>Daily (automatic) and on-demand (manual)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Accuracy</th>
<th>±3 m, with good sky view</th>
</tr>
</thead>
</table>

### PHYSICAL SPECIFICATIONS

<p>| Dimensions | |
|------------||</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Length</strong></td>
<td>14.9 cm (5.9 in)</td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td>6.3 cm (2.5 in)</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>25.0 cm (9.9 in)</td>
</tr>
</tbody>
</table>

| **Enclosure Material** | Weather-, impact-, and UV-resistant polymer |
| **Enclosure Rating**   | IP56, NEMA 3R     |
| **Enclosure Access**   | Hinged door with latches and eyelets for lock or zip tie |

| **Sensor Input Ports** | 6 (supports METER analog, digital, or pulse sensors) |
| **Sensor Port Type**   | 3.5-mm stereo plug connector |

| **Memory Type**        | Nonvolatile flash, full data retention with loss of power |

| **Data Storage**       | |
| **ZL6 Basic**          | 2 MB (20,000 to 30,000 records depending on configuration) |
| **ZL6, ZL6 Pro**       | 8 MB (40,000 to 80,000+ records depending on configuration) |

| **Battery Capacity**   | |
| **ZL6 Basic**          | 6 AA alkaline batteries |
| **ZL6, ZL6 Pro**       | 6 AA NiMH or alkaline batteries |

| **Battery Life**       | |
| **Alkaline**           | 3–12 months depending on configuration |
| **NiMH**               | 3+ years with unobstructed view of sun Charging through solar energy harvesting or USB |

| **Operating Temperature Range** | |

<table>
<thead>
<tr>
<th>Minimum</th>
<th>–40 °C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum</td>
<td>+60 °C</td>
</tr>
</tbody>
</table>

### 3.2 HARDWARE COMPONENTS

The ZL6 data logger is housed in a weather-resistant enclosure (IP56 rated) ([Figure 14](#)). In extremely wet environments or environments with prolonged high humidity, enclose a desiccant packet inside the logger or enclose the logger in a waterproof case. The ZL6 and ZL6 Pro have an integrated solar panel to recharge NiMH batteries.

![Figure 14 ZL6 data logger exterior](image)

The ZL6 is purpose-built to collect data from environmental sensors sold by METER. The data logger has six ports for sensors and a micro-USB port for communicating with a computer ([Figure 15](#)). The data logger interior also contains a TEST button ([Section 3.2.3](#)) and two status lights, OK and ERROR ([Section 3.2.4](#)). The logger uses six batteries ([Section 3.2.5](#)).
3.2.1 SENSOR INTERFACE

The ZL6 will detect the presence of METER sensors when connected to the sensor ports. For METER digital sensors, the ZL6 will detect and autopopulate the Sensor Type dropdown on the Manage Settings dialog in ZENTRA Utility (Section 4.2.5.1). For METER analog sensors, the ZL6 will show Unrecognized Sensor in the Sensor Type dropdown. Some sensors (such as pulse sensors) will not be detected by the ZL6. In these latter two cases the sensor will have to be manually selected from the dropdown menu.

NOTE: It is critical that the ZL6 is configured correctly for the attached sensors. Without correct configuration, the ZL6 will not record useful sensor information.

The ZL6 is able to detect when many of the METER sensors are unplugged or malfunctioning. The logger stores error codes in the place of normal sensor measurements in this event. ZENTRA software will display these errors to help troubleshoot problems with the sensors. The ZL6 cannot determine the difference between an intentionally uninstalled sensor and a malfunctioning sensor. Update the sensor configuration each time sensors are removed from or added to the ZL6.
3.2.2 SENSOR MEASUREMENT INTERVAL

The measurement interval controls how often the ZL6 records sensor data to internal nonvolatile data storage. The interval applies to all ports on the ZL6 (i.e., the ZL6 cannot store data for one sensor at a faster rate than another sensor). This setting is controlled in the Sensor Configuration tab of the Manage Settings dialog (Section 4.2.5.1).

The measurement interval works relative to the ZL6 internal real-time, 24-h clock. For example, a measurement interval of 60 min results in the ZL6 storing data every hour, on the hour (e.g., 12:00 am, 1:00 am, ..., 10:00 pm). The ZL6 and ZL6 Pro minimum measurement interval is 5 min and the maximum measurement interval is 12 h. For most applications, a measurement interval of 60 min is appropriate. The ZL6 Basic measurement interval is 60 min.

The ZL6 makes a measurement from each of the sensor ports in use every 60 s. When the ZL6 internal clock reaches the user-configured measurement interval, the ZL6 processes and stores the results from all the 60-s sensor readings taken since the last storage interval. For most sensors, the stored results are a simple average of the per-minute readings. For example, if the measurement interval for a TEROS 12 soil moisture sensor is 60 min, the ZL6 stores an average of the past 60 sensor readings. For a pulse-based sensor, such as a rain gauge, the ZL6 stores summed sensor readings. Some METER sensor user manuals contain more details of how the ZL6 processes sensor readings.

NOTE: Setting the ZL6 measurement interval to Off (not logging) turns off sensor measurement, data storage, and data uploads.

3.2.3 TEST BUTTON

Pressing the TEST button initiates the self-test sequence. The self-test can take 60 s or more if testing communications over the cellular network. The following actions are part of the self-test sequence:

• Reboot the ZL6.
  This ensures internal software restarts and operates in the expected way. Both status lights stay on during the reboot. This reboot will not erase data or reset settings.

• Perform basic functionality testing on internal systems and evaluates the amount of charge in the battery.
  Both the green and red lights blink together slowly while the logger performs tests.

• Autodetect the connected sensors (Section 3.2.1).

• Start the embedded GPS receiver to obtain a current time and location fix (Section 3.2.6).
  This process takes as long as 15 min to complete.

• Establish an internet connection over the cellular network and attempt to communicate with ZENTRA Cloud.

• Enable the Bluetooth module to allow connection with ZENTRA Utility Mobile.
After completing the self-tests, the ZL6 will indicate success or failure by lighting either the green or red status light.

A solid green light (for approximately 20 s) indicates that internal tests passed and there is successful communication over the cellular network.

A solid red light indicates an error in the logger, which may indicate:
- corrupt ZL6 logger firmware
- low batteries, or
- unsuccessful cellular communications (ZL6 and ZL6 Pro).

Use ZENTRA Utility to identify where the self-tests may have failed (Section 4.1) or consult troubleshooting to resolve logger errors (Section 5.2).

### 3.2.4 STATUS LIGHTS

Lights near the TEST button indicate the status of the ZL6. A green light is labeled OK and a red light is labeled ERROR. There are several possible status states:

- The green light gives a short, single blink every 5 s to indicate the ZL6 is configured to log sensor data.
- The green light blinks slowly (1 s on, then 1 s off), to indicate the logger is communicating to a computer or using the cellular module.
- The green and red lights blink together during self-test procedures (after pressing the TEST button or pulling the battery tab).
- The solid green or the red light at the end of the self-test sequence indicates the results of the tests.
- The lights remain off if the logger measurement interval is set to Off (not logging).

### 3.2.5 BATTERIES

The ZL6 and ZL6 Pro is designed to use either AA NiMH rechargeable batteries or AA alkaline nonchargeable batteries. The logger autodetects the type of batteries installed and automatically adjusts the internal thresholds to represent 100% and 0% battery power. The ZL6 Basic is designed for AA alkaline batteries.

**NOTE:** Do not mix NiMH and alkaline batteries together. Do not mix new and old alkaline batteries together.

Use NiMH batteries if the ZL6 or ZL6 Pro will be installed outdoors, where it can harvest solar energy to charge NiMH batteries. Orient the ZL6 enclosure to expose the solar panel to the maximum amount of sunlight available. In the northern hemisphere, this typically means that the data logger will face south; in the southern hemisphere, this typically means that the data logger will face north. There may be local obstructions that make another orientation more favorable. The logger will charge the batteries even during periods of low light levels (e.g., winter time or heavy overcast conditions). For extended periods of low
light, the incoming energy may be lower than the energy needed to operate the logger. The batteries will buffer the energy needs of the logger for several months and will return to full capacity as the incoming energy exceeds the energy needed to operate the logger.

The ZL6 and ZL6 Pro will also harvest energy from the USB connection to a computer. Plugging the logger into a USB port for several hours will help restore NiMH batteries to full capacity.

Use alkaline batteries if the ZL6 or ZL6 Pro will be installed indoors or in a location where the harvested solar energy is not sufficient to keep the NiMH batteries charged. Alkaline batteries will last longer than NiMH batteries that are not being charged (6 to 7 months for typical configurations).

The ZL6 and ZL6 Pro are designed to prioritize sensor measurements over both the GPS and cellular communications features. If the battery level reaches a critical threshold (showing 0% in software), the logger will continue to make sensor measurements until the battery charge is too low to provide excitation power to the sensors. When new batteries are installed or recharged, the GPS receiver and cellular radio functionality will automatically start working again.

Logged data are stored with nonvolatile flash memory and will not be lost if battery power fails. However, power must be restored to the logger to download data.

### 3.2.6 GPS RECEIVER (ZL6 SELECT MODELS)

The ZL6 logger has a built-in GPS receiver that provides the latitude, longitude, and altitude of the logger. It is designed to provide time fix and location metadata for the environmental monitoring location. The ZL6 does not record the location of each individual sensor reading and is not optimized for applications such as geotagging a moving sensor platform.

The ZL6 enables the GPS receiver once per day. If the logger determines its location has not changed, it turns off the GPS receiver to save power. If the ZL6 detects a change, it keeps the GPS receiver powered for as long as 15 min to improve the accuracy of the location fix. Pressing the TEST button on the ZL6 triggers the logger to evaluate changes in location (Section 3.2.3).

### 3.2.7 TIMEKEEPING

The ZL6 keeps track of time using Universal Time Coordinated (UTC) seconds. All ZL6 models can synchronize time using ZENTRA Utility and ZENTRA Utility Mobile. Additionally, the ZL6 and ZL6 Pro synchronize time using the GPS receiver or the cellular network. The ZL6 prioritizes using GPS time since this will be the most accurate; however, the logger will fall back to the other sources of time when the ZL6 does not have a good GPS time fix.

NOTE: The ZL6 Basic requires a time sync to accurately save a time and date stamp with each sensor measurement record. This time sync happens when the logger connects to ZENTRA Utility or ZENTRA Utility Mobile. The time must be reset any time the logger loses power (when batteries are removed or replaced).
Data collected by the ZL6 uses the UTC time for the timestamp on each saved sensor record. ZENTRA Utility and ZENTRA Cloud display these data using local time based on where the logger is installed.

### 3.2.8 DATA STORAGE

The ZL6 only stores data for sensor ports that are configured for sensors (Section 3.2.1).

The ZL6 Basic stores 2 MB of data and the ZL6 and the ZL6 Pro store 8 MB of data. When the logger has filled its memory, it begins overwriting the oldest data in the memory. Data storage capacity varies between approximately 6 months to several decades depending on the logger, connected sensors, and set measurement interval. ZENTRA Utility software displays how many days of data the ZL6 can hold based on the current measurement interval (Section 3.2.2), sensor configuration, and previously stored data.

The ZL6 data memory is nonvolatile flash. Removing the batteries or rebooting the logger (Section 3.2.3) will not erase stored sensor measurement data.

The ZL6 stores encoded data for each sensor to make data storage and transmitting convenient. ZENTRA software automatically decodes the sensor data to display them correctly.

### 3.2.9 ZENTRA CLOUD COMMUNICATIONS (ZL6 AND ZL6 PRO)

The ZL6 has built-in communication hardware for reporting sensor measurement data to ZENTRA Cloud. This allows for near real-time monitoring of the environment at the measurement site.

The ZL6 powers the communication hardware only long enough to upload the data collected since the last time the logger successfully reported. During these upload times the ZL6 transfers data to ZENTRA Cloud, retrieves any pending settings changes, and occasionally performs operating system update to the logger.

For ZL6 units with cellular hardware, upload session frequency and timing can be changed in ZENTRA Utility (Section 4.2.5.1) or ZENTRA Cloud. The default setting is for the ZL6 to upload data once per hour at a random time within each hour of the day at optimal hours. Less frequent uploads conserve battery power.

Contact Customer Support if more frequent uploads are needed.

The ZL6 is available with several versions of cellular communication modules. Please contact Customer Support or a METER sales partner for more information on the configuration that is best for the location where you plan to deploy the instrument.

For ZL6 units with Wi-Fi hardware, the logger will upload data within several minutes of storing the data. The frequency and timing of these uploads are not adjustable.
4. WI-FI COMMUNICATION

This section reviews the ZL6 Wi-Fi communications and configurations.

4.1 CONFIGURING ZL6 FOR WI-FI NETWORKS

A ZL6 logger using Wi-Fi for communications with ZENTRA Cloud operates much the same as the cellular-enabled version of the hardware as documented throughout this manual. The key difference is a ZL6 with Wi-Fi hardware requires the relevant settings to enable a connection to a Wi-Fi network. This is done using ZENTRA Utility Mobile. Once connected to a Wi-Fi network, the logger operates similar to the cellular version.

Use ZENTRA Utility Mobile to configure the ZL6 for a Wi-Fi network. The process starts the same for all supported Wi-Fi network types.

Press the TEST button on the logger to enable Bluetooth communications. Choose the ZL6 from the Connect screen in the app. ZENTRA Utility will connect to the ZL6 and retrieve the current configuration and status.

![ZL6 Wi-Fi connection process](image)

Figure 16  ZL6 Wi-Fi connection process

Tap Configure on the main screen. Then tap Configure Wi-Fi Network to start the connection process. ZENTRA Utility asks the ZL6 for a list of Wi-Fi networks within range of the logger.
ZENTRA Utility lists up to 12 of the Wi-Fi networks reported by the ZL6. Secure networks that require a passphrase are shown with a lock icon. Tap the name of the network to select the network ZL6 should be used to communicate with ZENTRA Cloud.

There are several reasons a desired Wi-Fi network isn't shown on the list. The signal strength may not be strong enough because the ZL6 is not close enough to the access point. The ZL6 is compatible with IEEE 802.11b/g/n 2.4 GHz Wi-Fi networks. The ZL6 cannot join a network using only the 5 GHz bands. The network may not be broadcasting the name. See section 4.5 for how to configure the ZL6 for a hidden Wi-Fi network. The Wi-Fi hardware inside the ZL6 auto-detects which regulatory region where it is operating. For many locations in the world, including the USA, the module disables Wi-Fi channels 12 & 13. Check the Wi-Fi access point configuration to verify it is not using channels 12 & 13 (or set to auto-select the channel when channels 12 & 13 are an option). The ZL6 only supports channels 12 & 13 when deployed in the ETSI/UKCA region.
4.2 OPEN NETWORK CONFIGURATION
The ZL6 is compatible with personal Wi-Fi networks that are not secured. This type of network doesn’t require a passphrase.

NOTE: Some open networks employ a captive portal. The ZL6 is not compatible with this type of network.

Figure 18  Configuration of open network

Tap Join to send the network settings to ZL6. The logger proceeds to connect to this Wi-Fi network and communicate with ZENTRA Cloud. ZENTRA Utility Mobile will report any errors.
4.3 SECURED PERSONAL NETWORK CONFIGURATION

The ZL6 is compatible with personal secured Wi-Fi networks. These are the most common kind of networks used in homes and small businesses. This type of network requires a passphrase that is at least 8 characters long.

![Configuration of personal secured network](image)

Figure 19  Configuration of personal secured network

Enter the passphrase and then Tap **Join** to send the network settings to ZL6. The logger proceeds to connect to this Wi-Fi network and communicate with ZENTRA Cloud. ZENTRA Utility Mobile will report any errors.
4.4 SECURED ENTERPRISE NETWORK CONFIGURATION

The ZL6 is compatible with some Wi-Fi networks employing enterprise security. These types of networks are used in larger businesses and universities. Typically, enterprise networks require IT professionals to deploy and support. The ZL6 is compatible with enterprise networks that are secured by a username and password using LEAP and PEAP methods. See Section 4.1 for networks that require authentication with certificates.

![Configuration of an enterprise network](image)

Enter the username, password, and security type and then Tap **Join** to send the network settings to ZL6. The logger proceeds to connect to this Wi-Fi network and communicate with ZENTRA Cloud. ZENTRA Utility Mobile will report any errors.
4.5 HIDDEN WI-FI NETWORK CONFIGURATION

Some Wi-Fi networks are configured not to broadcast their network name. These are known as hidden networks. These networks could be secured with personal or enterprise authentication methods. The ZL6 is compatible with hidden personal networks and is also compatible with hidden enterprise networks described in (Section 4.4) above.

Figure 21  Configuration of hidden personal network

Connecting to a hidden Wi-Fi network requires you to enter the network name and security credentials. Consult your IT professional if you are unsure of the settings to use with the hidden network. Tap Join to send the network settings to ZL6. The logger proceeds to connect to this Wi-Fi network and communicate with ZENTRA Cloud. ZENTRA Utility Mobile will report any errors.
4.6 INCOMPATIBLE WI-FI NETWORKS

The ZL6 is not compatible with the following types of Wi-Fi networks. Consult an IT specialist for assistance if the network intended to be used with the ZL6 is one of the following incompatible networks.

The ZL6 is not compatible with Wi-Fi networks that employ captive portal technology. Captive portals are commonly used with open Wi-Fi networks to present a network login page or to require a compliance agreement with an acceptable use policy before allowing network access. The ZL6 is unable to interact with these requirements. It is not possible for ZENTRA Utility mobile to identify networks using a captive portal. During the configuration process, ZENTRA Utility Mobile will likely alert that the ZL6 does not have internet access even if it successfully connected to the Wi-Fi network.

Suggested work around for networks using a captive portal: provide the network administrator with the MAC address for the ZL6 so it can be added to the network whitelist.

The ZL6 is not compatible with enterprise Wi-Fi networks that require security certificates to be loaded onto the clients using the network. These networks typically use certificates instead of usernames and passwords to enable network access. Networks secured with the EAP-TLS method is an example of an incompatible network. ZENTRA Utility Mobile and the ZL6 do not currently support transferring security certificates to the Wi-Fi module embedded in the ZL6.

Suggested work around for networks using security certificates: work with your IT professional to deploy a dedicated Wi-Fi network for the ZL6 hardware that uses supported network security.

The ZL6 is not compatible with networks that require the hardware to use statically assigned IP address configuration. It is not currently possible to configure the ZL6 to use a static IP address with ZENTRA Utility Mobile. The ZL6 only interacts with ZENTRA Cloud over the internet so a dynamically allocated IP address is sufficient.

Suggested work around for networks requiring static IP address: provide the network administrator with the MAC address for the ZL6 so it can be given a fixed IP address via DHCP.
4.7 COMMUNICATION TEST

A successful communication test will confirm that the ZL6 can transmit data to ZENTRA Cloud servers as well as provide the quality of the Wi-Fi connection. Even a poor connection status allows data to be successfully transferred. Prior to installing the sensors and the ZL6, check the Wi-Fi connection quality at the location:

Tap the TEST button on the Actions panel and select Start Test.

![Figure 22  Upload test showing Wi-Fi information](image)

Alternatively the Wi-Fi network access point may also be moved closer to the logger to ensure good communications.

4.8 USING THE ZL6 INDOORS

The ZL6 is designed to withstand the weather of outdoor environments. It also works well in a laboratory environment indoors. Deploying Wi-Fi enabled ZL6 loggers indoors is common.

The solar energy harvesting feature of the ZL6 may not work well enough indoors to keep the rechargeable NiMH batteries charged. Consider using Alkaline batteries for indoor applications. Contact Customer Support for additional power options.

4.9 TROUBLESHOOTING WI-FI CONNECTIONS

For troubleshooting the ZL6 Wi-Fi connection see Table 3 Troubleshooting the ZL6 (Section 6.2). Contact Customer Support if further assistance is needed.
5. ZENTRA SOFTWARE

The ZL6 is designed to work with ZENTRA Utility Mobile, ZENTRA Utility, and ZENTRA Cloud. ZENTRA Utility Mobile communicates with the ZL6 using Bluetooth to configure the ZL6 and upload data to ZENTRA Cloud (Section 4.1). ZENTRA Utility communicates with the ZL6 via USB to configure the ZL6, download data to a computer, and upload these data to ZENTRA Cloud (Section 4.2). ZENTRA Cloud is a web-based application to remotely view and share environmental data, download spreadsheets, and configure the ZL6 (Section 4.3).

5.1 ZENTRA UTILITY MOBILE

ZENTRA Utility Mobile for iOS or Android Mobile Devices is a user-friendly interface for configuring and downloading data from the ZL6 logger that can be used on Apple (iPhone iOS 9.0 and newer) or Google (Android 4.3 and newer) smartphones or tablets. With ZENTRA Utility, the user can connect to ZL6 loggers directly to

- configure operation logger parameters,
- test ZL6 and ZL6 Pro cellular and Wi-Fi communications
- troubleshoot real-time sensor measurements (scan sensors).

ZENTRA Utility Mobile launches with an in-app tutorial to illustrate the important features of the app. Select More > In-App Tutorial to review this tutorial at any time. Use the Connect screen to select the ZL6 and use the ZENTRA Utility Mobile main screen to configure the logger and check sensor measurements.

![ZENTRA Utility Mobile main screen](image)

**Figure 23** ZENTRA Utility Mobile main screen
5.2 ZENTRA UTILITY
ZENTRA Utility for Windows or Mac Computers is a user-friendly interface for configuring and downloading data from the ZL6 logger that can be used on any MacOS (10.9 and newer) or Microsoft Windows (7 and newer) laptop, netbook, or desktop computer. With ZENTRA Utility, the user can connect to ZL6 loggers directly to

- set all logger configuration parameters,
- test ZL6 and ZL6 Pro cellular communications,
- make real-time sensor measurements (scan sensors),
- create Excel files with sensor data, and
- upload data to ZENTRA Cloud.

The ZENTRA Utility main screen should appear upon launch (Figure 17). Use the Menu bar and Button toolbar to interact with the ZL6.

5.2.1 BUTTON TOOLBAR
The Button toolbar provides shortcuts for the most frequent actions in using and configuring the ZL6 (Figure 17):

- **COM port dropdown menu:** Lists USB devices connected to the computer.
- **Connect/Disconnect:** Click the **Connect** button to attempt to connect to the device currently selected in the **COM port dropdown menu**. Click the **Disconnect** button to disconnect from the currently connected logger.
- **Scan:** Queries the connected ZL6 for the current sensor readings and updates the active sensors and measurements area.
• **Download**: Downloads all data that has been collected on the ZL6 since the last time a download from the selected logger.

• **Settings**: Opens the Manage Settings dialog (Section 4.2.5.1).

• **Test**: Opens the Cellular Communication Test dialog (Section 2.2.2).

---

**5.2.2 DATA LOGGER IDENTIFICATION AREA**

The Data Logger Identification area shows information for the connected ZL6. Hover over each item for its label. Any customizable fields can be adjusted through the Manage Settings dialog (Section 4.2.5.1).

• **Serial Number**: The factory-set unique serial number for each ZL6.

• **Device Type**: Model ZL6 or ZL6 Basic.

• **Site Name**: Customizable field to describe the ZL6 location.

• **Remaining Battery Life**: Icon that shows the battery charge remaining on the device.

• **Cellular Strength**: Icon that shows the strength of the cellular signal. This appears only after the cellular communication test is completed (Section 2.2.2).

• **Device Name**: Customizable field to describe the ZL6 device.

• **Firmware Version**: Version of firmware on the ZL6.

• **Measurement Interval**: Customizable field that describes the frequency at which the ZL6 will be recording measurements (Section 3.2.2).

• **Time until Overwriting Data**: Indicator of how much data are stored on the ZL6 and how long it will be able to record more measurements before overwriting older data.

---

**5.2.3 ACTIVE SENSORS AND MEASUREMENTS AREA**

All sensors plugged into the ZL6 are listed in this area and each sensor in this section is delimited by a horizontal bar (Figure 17). The left side of the section will have the sensor name and port number. The two on-board sensors (Battery and Barometer) will not show a port number. The right side of the section will list all measurements from the sensor, with a descriptor of the value. The measurements will use the units selected in the Manage Preferences Dialog (Section 4.2.5).

---

**5.2.4 STATUS BAR**

The Status bar in the bottom border of the screen will include what is happening in the software. It also shows the logger date and time.
5.2.5 MENU BAR
ZENTRA Utility Menu bar has six menus to access the program features: File, Data, Edit, Actions, Window, and Help.

FILE MENU
The File menu includes two options:
• **Disconnect**: Disconnect from a logger and end communications.
• **Quit**: Closes ZENTRA Utility.

DATA MENU
The Data menu has three options:
• **Download Data Since Last Download**: Download the data stored since the last successful download.
• **Download All Data**: Download all the data currently stored in the ZL6.
• **Erase**: Deletes all stored data.

Section 2.2.4 provides instructions for downloading data from the ZL6 logger.

The data downloaded by ZENTRA Utility will be calibrated correctly for each sensor type, except for soil moisture sensors. ZENTRA Utility uses a default calibration for soil moisture sensors that is appropriate for most mineral soils, but a custom calibration may be needed for the particular soil type. If a different soil moisture sensor calibration is necessary, change the Measurement Units to Raw VWC in the Manage Preferences tab. Raw VWC values will be downloaded in the Processed Data worksheet for use as inputs to custom calibration equations. See each specific sensor manual for alternative calibrations that can be applied to the raw data.

EDIT MENU
The Edit Menu allows the user to edit preferences in the Manage Preferences dialog. These preference configurations will only be saved to the computer, not as measuring preferences in the ZL6 memory. It has four tabs for navigation:
• Measurements Tab (Figure 19):
  • **Measurement Units**: Set preferences for measurement units by using the dropdown menus. Click **OK** to apply the changes.
• Data File Tab (Figure 20):
  • **Date and Time Display in ZENTRA Utility:** Change the format of date and time values by selecting an option from the dropdown menus. This controls how date and time are shown in ZENTRA Utility display and in the downloaded files.

• Application Tab (Figure 21):
  • **Automatic Internet Version Check:** Select the checkbox to automatically be notified when a new ZENTRA Utility version becomes available. Updates can be searched for
manually at any time in the Help menu.

- **Automatic Clock Synchronization:** Select the checkbox to keep the device clock synchronized with the connected computer clock. The date and time can also be updated by using the Actions menu.

If the computer will not always have the correct time zone setting for the logger sites, deselecting this option will not override the setting in the logger.

![Figure 28  Application tab](image)

- **Communications Tab** *(Figure 22)*:
  - **Device Commands Retries:** Modifies the number of times ZENTRA Utility sends commands to a logger.
  - **Extra Response Time:** Modifies the length of time ZENTRA Utility waits for a response from the logger.
  - **Communication Ports List:** Enable this option if the USB device does not appear in the Connect dropdown list.

  **NOTE:** Enabling this option may also find COM ports that are unavailable for use by ZENTRA Utility.

- **Power Noise Filter:** Set the Power Frequency to eliminate electrical noise that comes from an AC power distribution system.

  In North America and most of Asia, the frequency of the power cycle is 60 Hz (the default value); in most of Europe it is 50 Hz. This feature only needs to be set once, and the program will automatically update each connected device filter.
**ACTIONS MENU**

The Actions menu is the primary menu for configuring and testing the ZL6 series logger.

- **Select Sensors:** Displays the Sensor Configuration tab in the Manage Settings dialog (Section 4.2.5.1).

- **Set Device Time:** Instructs ZENTRA Utility to set the ZL6 time and date according to the time and date on the computer.

- **Digital Sensor Terminal:** Sends commands through the ZL6 logger to a compatible METER digital sensor. This feature can be used to troubleshoot the sensor by sending SDI-12 digital sensor communication commands. See respective sensor documentation for additional information on SDI-12 commands.

- **Test:** Evaluates the ZL6 logger wireless signal (Section 2.2.2).

- **Cellular Configure:** Displays the Communication Settings tab in the Manage Settings dialog (Section 4.2.5.1).

- **List Cellular Carriers:** Queries the cellular module in the ZL6 logger for a list of carriers it detects. This is useful when trying to troubleshoot cellular connection problems. **NOTE:** The ZL6 may not be authorized to operate on any or all the carriers listed.

- **Device Information:** Displays the Device Information tab in the Manage Settings dialog (Section 4.2.5.1).

- **Device Location:** Displays the GPS Location tab in the Manage Settings dialog (Section 4.2.5.1).
• **Show Raw Data/Show Processed Data:** Toggle showing raw or processed data in the instantaneous measurements area of the main screen. Use the raw data display to help troubleshoot poor sensor measurements.

**WINDOW MENU**
The Window menu provides the Show Terminal option. This allows for direct entry of commands to the ZL6 and is mainly used for troubleshooting.

**HELP MENU**
The Help menu has five options.

• **Check for Software Updates:** Checks for the newest available version of the ZENTRA Utility. If a newer version is available, a prompt will appear to install the update. The computer must be connected to the internet for this feature to work. ZENTRA Utility checks for newer versions of the program each time it launches. It will download these updates in the background automatically.

• **Check for Logger Firmware Updates:** Checks for the newest version of ZL6 firmware from METER. If a newer version is available, ZENTRA Utility downloads the firmware in the background.

  When ZENTRA Utility connects to an ZL6, it compares the firmware on the logger with the latest version available. If the ZL6 firmware is out of date, ZENTRA Utility will prompt to start a firmware update for the logger. ZENTRA Utility maintains a cache of logger firmware to allow field firmware updates without a connection to the internet.

• **Update Sensor Firmware:** Some METER sensors (e.g., ATMOS and TEROS sensors) allow for firmware updates via ZENTRA Utility. Please consult the sensor user manual for more details.

• **Send Feedback to METER:** Sends product feedback, bug reports, or feature requests to METER when connected to the internet (*Figure 23*).
Enter name, company name, and contact information in the form.
Identify the type of feedback being sent (general feedback, feature suggestions, bug report, or other).
Indicate if and how METER should respond (email or telephone).
Give details in the description area. If reporting a bug, detail what steps occurred prior to the bug and any error message. By default, bug reports include software error files. Other files can also be sent using this form (e.g., logger download files).

- **About ZENTRA Utility**: View the version of ZENTRA Utility currently installed.

**MANAGE SETTINGS DIALOG**

Changing the ZL6 configuration happens in the Manage Settings dialog, which has four tabs. Use the following steps to access the Manage Settings dialog:

1. Click **Settings** on the Button toolbar (**Section 4.2.1**).
2. Make edits to the settings on the tabs. Refer to the details about the types of control settings in the following sections.
3. Click **OK** to save settings.
   
   Click **Cancel** to exit without applying settings.
DEVICE INFORMATION TAB
Use the Device Information tab to edit the information that appears in the Data Logger Identification area (Figure 24).

• **Device Name:** Logger-specific name to identify the logger in the software. The default name is the unit serial number. It can be changed to a name representing the field or plot where the logger is installed or the types of sensors installed.

• **Site Name:** Area-specific name to identify where a group of loggers are located in the software. The Site Name is optional.

• **Serial Number:** Factory-set logger serial number that cannot be changed.

• **Time Zone:** Time zone automatically set from ZENTRA Utility software or the cellular system.

• **Firmware Version:** Version of firmware on the ZL6. Check for the latest version of logger firmware, using the Help menu (Section 4.2.5).

• **Device Type:** Model of the ZENTRA logger connected to ZENTRA Utility (not editable).

![Manage Settings Device Information tab](image)

Figure 31  Manage Settings Device Information tab

SENSOR CONFIGURATION TAB
Use the Sensor Configuration tab to set the sensor measurement interval and to select sensors for each port (Figure 25).
• **Measurement Interval:** Controls how often the ZL6 stores sensor data (Section 3.2.2). The ZL6 Basic has only two options: 60 min and Off (not logging).

  **NOTE:** Setting the measurement interval to **off (not logging)** turns off sensor measurement, data storage, and data uploads.

• **Data Storage:** Shows the percentage of logger storage currently used and an approximation of when the logger will begin overwriting the oldest data. This calculation is based on the data already stored, measurement interval, and existing sensor types configured in each port of the logger.

• **Sensor port tabs:** Displays sensor type and firmware version (when applicable) for each sensor port on the logger. Select the correct sensor type from the dropdown menu to ensure correct sensor measurements.

  **NOTE:** Only digital sensors have firmware versions.

![Figure 32 Manage Settings Sensor Configuration tab](image)

**COMMUNICATION SETTINGS TAB**

Use the Communication Settings tab to control upload frequency and times for the ZL6 (Figure 26). This tab is unavailable for the ZL6 Basic.

• **Upload frequency for each selected hour:** Enable or disable automatic data uploads from the ZL6 to ZENTRA Cloud. The Upload Frequency describes how often data are uploaded and is a different setting than the sensor measurement interval. Data are sent once per hour. If more frequent uploads are needed, please contact **Customer Support**. METER offers cellular service plans that support uploading data every 15 min.
• **Upload Times:** Choose the approximate times of day that data are uploaded from the logger to ZENTRA Cloud. The data will be uploaded at a random time during each selected hour to upload data. To account for this variation, choose times prior to when the data are needed. By default, the ZL6 is configured to upload data at optimal hours to conserve battery. To conserve battery power further, choose fewer upload times.

![Figure 33 Manage Settings Communication Settings tab](image)

**GPS LOCATION TAB**

The GPS location information in this tab is automatically provided by the GPS receiver built into the ZL6 and ZL6 Pro (Figure 27). The time zone is set by the computer or cellular network.

- **Latitude and Longitude:** Provides GPS location of the ZL6.
- **Altitude:** Contains altitude from sea level of the ZL6.
- **Time Zone:** Offset from UTC time zone of the ZL6.
5.3 ZENTRA CLOUD

ZENTRA Cloud is a cloud-based web application to download, view, and share ZL6 data as well as change logger configurations. ZENTRA Cloud is also designed to make it easy to share data with colleagues. A trial of ZENTRA Cloud is included with each ZL6 purchase. This manual offers only instructions to logging in to ZENTRA Cloud. Use the online help files to learn more about all the features of ZENTRA Cloud.

The first step to using the ZL6 with ZENTRA Cloud is to create a customer site (a group of users and loggers).

1. Navigate to the server listed on the orange subscription card (zentracloud.com or zentracloud.cn) (Figure 28).

   ![Device Subscription Card](image)

   **Figure 35** Sample device subscription card

2. Click the Sign Up button.
3. Enter the required information, including a valid email address.
4. Accept the terms and conditions.
5. Click Sign Up.
   ZENTRA Cloud will send an email confirmation.
6. Click the link in the confirmation email inside email application.
7. Log in to ZENTRA Cloud.

To view data from ZL6 loggers on the customer site, subscribe to each desired ZL6 logger on ZENTRA Cloud following the steps below. A logger can only belong to one site at a time.

NOTE: Depending on the organization, labels may be Farm and Field or Site and Plot. These designations can be changed at any time.

1. Select New Farm on the ZENTRA Cloud home screen.
2. Give the Farm a name.
   A Farm can contain one or more Fields.
3. Select New Field.
4. Associate this Field to the Farm.
5. Give the Field a name.
   A Field can contain one or more loggers.
7. Choose the Farm and Field.
8. Fill in the ZL6 Device Serial Number and Device Password as shown on the device subscription card (Figure 28).

Once subscribed to a ZL6, the logger should appear on the map and sensor data can be viewed and downloaded. Logger settings can be changed using ZENTRA Cloud. ZENTRA Cloud also provides a convenient way to share data from ZL6 loggers with colleagues, with user-set permissions. See the online help files for more information.
6. SERVICE
This section describes the maintenance of the ZL6. Troubleshooting solutions and customer service information are also provided.

6.1 MAINTENANCE
The ZL6 may be returned to METER for maintenance (system inspection or replace old or damaged parts). Select replacement parts (e.g., USB cable, antenna, cable strain relief parts, or gaskets) can also be ordered from METER. Contact Customer Support for more information. ZENTRA Utility makes it easy to send feedback, bug reports, and feature requests to METER (Section 4.2.5).

The ZL6 requires little maintenance when installed correctly. Be sure to check the ZL6 logger periodically:
- Replace batteries as needed.
  NOTE: Do not mix NiMH and alkaline batteries together. Do not mix new and old batteries together.
- Inspect the battery holders to ensure they are clean and free of corrosion.
- Verify that the sensor ports are clean and that the sensors are making good contact with the ports.
- Clean the inside of the sensor ports with isopropyl alcohol and a swab if soil or other foreign materials are visible.
- Check case gaskets and strain relief hooks. Replace gaskets every 1 to 2 years, as needed.
- Replace zip ties securing the logger annually or as needed.
  NOTE: Never immerse the ZL6 in liquids or bury the ZL6. This and other misuse, improper protection, or improper installation may damage the ZL6 and void the manufacturer’s warranty.

NiMH batteries should last for several years if they are charging properly. Over a long period of time, NiMH batteries will begin to lose their charge capacity. If dark periods lasting months cause the batteries to discharge too low, it is time to replace the NiMH batteries. When replacing NiMH batteries, use high-quality batteries advertising higher charge capacity. New NiMH batteries may also be purchased from METER. Contact Customer Support to discuss concerns or recommendations.

Alkaline batteries should be replaced when the battery charge nears 0%. Replace batteries with high-quality alkaline batteries. A low-quality battery may not provide the desired battery life for the ZL6 logger.

NOTE: Installing or replacing the batteries in the ZL6 resets the internal real-time clock. The ZL6 requires a time sync to accurately save a time and date stamp with each sensor measurement record. The ZL6 and ZL6 Pro time can be set from ZENTRA Utility, the on-board GPS receiver, or the cellular network. Press the TEST button after changing the batteries to enable the GPS receiver to acquire a new time and position fix. The ZL6 Basic receives a time sync when the logger connects to ZENTRA Utility or ZENTRA Utility Mobile.
6.2 TROUBLESHOOTING

Although the ZL6 is designed for durability and built to the highest manufacturing standards, problems may occasionally occur. This troubleshooting section details the major problems and their solutions. If the problem is not listed or these solutions do not solve the issue, contact Customer Support.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZENTRA Utility cannot connect to the device</td>
<td>If using a Windows computer, reinstall the USB driver from <a href="https://meter.ly/ZL6-support">https://meter.ly/ZL6-support</a>.</td>
</tr>
<tr>
<td>or ZL6 logger not showing in the COM port picker</td>
<td>Mac computers running ZENTRA Utility do not require a custom USB driver. Check that the USB cable is securely plugged into the logger and the computer. Ensure the logger has good batteries. Press the TEST button on the logger to reset it. Connect to a second logger. If the connection works, the problem is likely with the first logger. Try a different micro-USB cable. Ensure the cable is not intended for charging only.</td>
</tr>
<tr>
<td>ZENTRA Utility reports it lost the connection</td>
<td>Check or replace the USB cable. Increase the number of times ZENTRA Utility tries sending commands to the logger: • Go to the Manage Preferences menu. • Select the Communication tab. • Increase the Direct Connect Retries.</td>
</tr>
<tr>
<td>ZENTRA Utility states there is no new data for downloading or Logger stopped making measurements</td>
<td>Wait for at least the length of the measurement interval to ensure the logger had enough time to record data. Ensure the logger is configured to measure data, i.e., make sure the measurement interval is not set to Off (not logging). Check the battery. The ZL6 will stop making sensor measurements when the batteries are extremely low. Press the TEST button to reset the logger.</td>
</tr>
<tr>
<td>Sensor measurement data does not seem to be correct</td>
<td>Switch the sensor to a known working port and scan again. If the problem follows the sensor, then the sensor may be damaged. Many issues affect the quality of the sensor measurement. Please see the sensor user manual for troubleshooting.</td>
</tr>
</tbody>
</table>
### Table 3  Troubleshooting the ZL6 (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solutions</th>
</tr>
</thead>
</table>
| Sensor data shows No response from sensor in the Scan window or Downloaded data shows #N/A | The raw data measured by the logger is out of expected range for the sensor. This could be caused by an unplugged or broken sensor.  
Ensure the sensor stereo plug is fully inserted into the logger sensor port.  
Ensure the sensor type shown in the Scan window matches the sensor connected to the logger.  
Switch the sensor to a known working port and scan again. If the sensor shows data, the port may be damaged. If the No response from sensor message is still presenting, the sensor could be unplugged or broken.  
If the problem persists, contact Customer Support. |
| Red ERROR light and/or green OK light are always on                      | Check logger batteries.  
Press the TEST button to reset the ZL6.  
If the problem persists, contact Customer Support. |
| Red ERROR light is on after pressing the TEST button                    | See Section 3.2.3 for information on the TEST button results and how to further troubleshoot.                                                     |
| Cellular uploads stopped working                                        | Press the TEST button to reset the ZL6.  
Run the Cellular Communication Test in ZENTRA Utility to determine if there is a communication error.  
Check the List Cellular Carriers function in ZENTRA Utility to confirm there are cellular carriers operating in the area.  
If the problem persists, contact Customer Support. |
| Logger does not seem to be working correctly or reliably                | Press the TEST button on the logger to reset the ZL6.  
Check logger batteries. Replace alkaline batteries if close to 0%. Recharge NiMH batteries if close to 0%.  
Check for corrosion or water damage. Check that the seals and gaskets are intact.  
If the problem persists, contact Customer Support. |
### Table 3  Troubleshooting the ZL6 (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water is found inside the logger</td>
<td>Precipitation can be trapped between the solar panel cover and the top of the door in windy conditions and drip into the logger. Wipe off the logger interior and the top of the door. If this problem recurs frequently, consider enclosing the logger in a waterproof case.</td>
</tr>
</tbody>
</table>

**ZL6 Wi-Fi Network Connections**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZENTRA Utility Mobile is not listing a desired Wi-Fi network even though the Wi-Fi network is showing on device running ZENTRA Utility Mobile</td>
<td>The Wi-Fi hardware in the ZL6 is compatible with Wi-Fi networks using the 2.4 GHz bands. ZL6 doesn’t work with networks using 5 GHz bands. The Wi-Fi radio connection between the ZL6 and the access point may be too weak. The ZL6 is only able to report information for up to 12 Wi-Fi networks during a scan. Try refreshing the scan. Alternatively use the process for connecting to a hidden network (Section 4.5) to configure the ZL6 to your network. The access point is using Wi-Fi channel 12 or 13 in a location where the Wi-Fi hardware determines these channels are unavailable. Change the access point to use a channel number in the range 1 to 11.</td>
</tr>
<tr>
<td>The Wi-Fi network at a university/government agency does not seem to be working with the ZL6</td>
<td>Wi-Fi networks using enterprise security can offer additional challenges for devices like the ZL6. Consider asking your IT professional to deploy a Wi-Fi access point for the ZL6 that uses a compatible form of network security. Contact customer support or METER sales partner to discuss alternative ways for your ZL6 to upload data to ZENTRA Cloud.</td>
</tr>
<tr>
<td>ZL6 uploads to ZENTRA Cloud appears to have stopped working</td>
<td>Try rebooting the Wi-Fi access point/router. ZL6 caches all unsent data to send when the connection is restored. Use the upload test (Section 4.7) to evaluate the connection to the Wi-Fi Access Point and ZENTRA Cloud. Use ZENTRA Utility Mobile to re-configure the ZL6 for your network. This step is necessary if the name of your Wi-Fi network changed or if the network passphrase changed.</td>
</tr>
<tr>
<td>ZL6 won't communicate directly with user over Wi-Fi</td>
<td>The ZL6 is not available on the Wi-Fi network for interactive communications. The ZL6 only powers the Wi-Fi module long enough to send sensor measurement data and status updates to ZENTRA Cloud after each measurement interval.</td>
</tr>
</tbody>
</table>
6.3 CUSTOMER SUPPORT

NORTH AMERICA
Customer service representatives are available for questions, problems, or feedback Monday through Friday, 8:00 am to 5:00 pm Pacific time.

Email: support.environment@metergroup.com
      sales.environment@metergroup.com
Phone: +1.509.332.5600
Fax: +1.509.332.5158
Website: metergroup.com

EUROPE
Customer service representatives are available for questions, problems, or feedback Monday through Friday, 8:00 to 17:00 Central European time.

Email: support.europe@metergroup.com
      sales.europe@metergroup.com
Phone: +49 89 12 66 52 47
Fax: +49 89 12 66 52 20
Website: metergroup.de

If contacting METER by email, please include the following information:

Name  Email address
Address Instrument serial number
Phone  Description of the problem

NOTE: For products purchased through a distributor, please contact the distributor directly for assistance.

6.4 TERMS AND CONDITIONS
By using METER instruments and documentation, you agree to abide by the METER Group, Inc. Terms and Conditions. Please refer to metergroup.com/terms-conditions for details.
APPENDIX A. COMPLIANCE CERTIFICATIONS
This appendix contains compliance statements that apply to the ZL6.

A.1 USA
This device complies with Part 15 of the FCC Rules. Operation is subject to the following conditions:

1. This device may not cause harmful interference.
2. This device must accept any interference received, including interference that may cause undesired operation.

The ZL6 series loggers contain one or more of the following radio modules, listed by their FCC identification numbers:

- SH6MDBT40: All ZL6 series (Bluetooth module)
- XPYLISAU201 or XPYLISAU200: ZL6 with 3G UMTS cellular module
- XPY2AGQN4NNN: ZL6 with 4G LTE-M cellular module
- XPYUBX21BE01: ZL6 with 4G LTE Cat 1 cellular module
- XPYNINAW1: ZL6 with Wi-Fi module

Changes or modifications to the ZL6 series loggers or antenna not expressly approved by METER Group, Inc. could void FCC compliance and thus the user’s authority to operate the equipment.

A.2 CANADA
Industry Canada (IC) Notices
This Class B digital apparatus complies with Canadian CAN ICES-3(B) / NMB-3(B) and RSS-210. Operation is subject to the following two conditions:

• This device may not cause interference
• This device must accept any interference, including interference that may cause undesired operation of the device

The ZL6 series loggers contain one or more of the following radio modules, listed by their IC identification numbers:

- 8017A-MDBT40: All ZL6 series (Bluetooth module)
- 8595A-LISAU201 or 8595A-LISAU200N: ZL6 with 3G UMTS cellular module
- 8595A-2AGQN4NNN: ZL6 with 4G LTE-M cellular module
- 8595A-UBX21BE01: ZL6 with 4G LTE Cat 1 cellular module
- 8595A-NINAW13: ZL6 with Wi-Fi module
Radio Frequency (RF) Exposure Information
This device has been evaluated and shown compliant with the IC RF Exposure limits under mobile exposure conditions (antennas are greater than 20cm from a person’s body).

Avis d’Industrie Canada (IC)
Cet appareil numérique de classe B est conforme aux normes canadiennes CAN ICES-3(B) / NMB–3(B) et RSS-210.

Son fonctionnement est soumis aux deux conditions suivantes:
• Cet appareil ne doit pas causer d’interférence
• Cet appareil doit accepter toute interférence, notamment les interférences qui peuvent affecter son fonctionnement

Informations concernant l’exposition aux fréquences radio (RF)
Ce périphérique a été évalué et démontré conforme aux limites d’exposition aux fréquences radio (RF) d’IC lorsqu’il est installé dans des produits hôtes particuliers qui fonctionnent dans des conditions d’exposition à des appareils mobiles (les antennes se situent à plus de 20 centimètres du corps d’une personne).

Changes or modifications to the ZL6 series loggers not expressly approved by METER Group, Inc. could void Industry Canada (IC) compliance and thus the user’s authority to operate the equipment.

A.3 EUROPEAN UNION
R&TTEd and European Conformance CE mark
Radiofrequency radiation exposure Information: this equipment complies with radiation exposure limits prescribed for an uncontrolled environment for fixed and mobile use conditions. This equipment should be installed and operated with a minimum distance of 20 cm between the radiator and the body of the user or nearby persons. This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter except as authorized in the certification of the product.

A full CE declaration of conformity for the ZL6 is available on request from METER Group.
The ZL6 series loggers contain one or more of the following radio modules that are TELEC/JATE certified.

All ZL6 series (Bluetooth module)
  • Technical Requirements certified type number: 201-160496

ZL6 with TELEC-approved 3G UMTS cellular module
  • Technical Conditions certified type number: AD120274003
  • Technical Requirements certified type number: 003-120375

ZL6 with 4G LTE-M cellular module
  • Technical Conditions certified type numbers: D180083003
  • Technical Requirements certified type number: 003-180155

ZL6 with 4G LTE Cat 1 cellular module
  • Technical Conditions certified type numbers: D220006003
  • Technical Requirements certified type number: 003-220017

ZL6 with Wi-Fi module
  • Technical Requirements certified type number: 204-810001
INDEX

B
battery
  charging 1, 23
  diagram 21
  installation 3, 23–24, 24
  life 19, 36
  replacement 24, 48
  types 23

cellular communication 11
cellular communication test 9, 15–16
cellular module 17, 25
communication settings 44–45
compliance
  CE 54
  IC 53
  TELEC 55
components
  antenna 10
  batteries 23–24
  enclosure 20–21
  GPS module 24
  included 2
  memory 25
  reference barometer 1
  status light 20, 23
  TEST button 20, 22–23
configuration 5–11
  computer communication 4
  sensor 7–11
  using ZENTRA Utility 4, 5–11
  using ZENTRA Utility Mobile 11–13
data collection
  metadata 11
  sensor calibration 37
  storage 19, 25, 44
timekeeping 24
data deletion 11–16
data download
  using ZENTRA Cloud 47
  using ZENTRA Utility 10, 36, 37
data loggers 1
e-mail address 52
fax number 52
firmware 36, 41, 43
GPS
  display 40, 45
  receiver 24
installation 3–4
  preparation 3
  sensors 5
  software 3
  solar panel optimization 4, 23
tools needed 3
maintenance 48
measurement interval 1, 22, 36
phone number 52
S
scan 10, 16
sensor measurements 10, 16
specifications
  communications 17–18
  measurement 17
  physical 18–19
support 41–42, 52

T
terms and conditions 52
troubleshooting 49–50
  cellular communication test 9
  sensor error codes 21
  status lights 23
  TEST button 22–23
  Wi-Fi network 51

W
Wi-Fi communication 26
  network configuration 26–31
problem. See troubleshooting
wireless data transmission
  cellular communication 25
  communication settings 44–45
  supported networks 40

Z
ZENTRA Cloud 1, 11, 46–47
ZENTRA Utility
  Actions menu 40–41
  active sensors 36
  button toolbar 35
  Data menu 37
  Edit menu 37–39
  File menu 37
  Help menu 41–42
  main screen 35
  scan 35
  settings 42–46
  Window menu 41
ZENTRA Utility Mobile
  configuration 4, 13–15
  installation 11–12